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MatchMover™ — the first product of the Image Processing Factory™

MatchMover isthe best "3D Camera Tracker" available and the only one running stand alone

under both Windows NTCI and IRIX®. Using new, breakthrough technology, MatchMover

captures any live-action camera motion in 3D (including zoom) by tracking 2D features in an

image sequence. No additional information is required about the camera or the scene. In addition,
MatchMover calculates the 3D coordinates of any 2D features. By exporting the camera data to
standard animation software, users can create image sequences of 3D scenes using the real live-
action camera path. For mixed 2D and 3D motion animation, MatchMover is indispensable!

The Image Processing Factory™

The Image Processing Factory is an integrated family of applications that streamline workflow
processes for computer graphics professionals involved in image processing, 3D modeling,
animation or special effects. With the Image Processing Factory, computer graphics professionas
can free their imagination and create!

Other REALVIZ Products

ReTimer™

ReTimer is the ultimate "Time Warper" to sow down or speed up motion sequences. The
software utilizes a revolutionary new method for creating new frames between actual framesin a
motion or still sequence. With this technique, superior-quality high speed and slow speed
sequences can be produced in lesstime and at lower cost. In addition, ReTimer enables animators
to smooth the motion of hand drawn or computer-generated ani mation sequences by increasing the
number of frames available for projection. And, fluid motion sequences can be created from a
sequence of just a few photos! ReTimer is a highly effective tool that provides new, easier and
less expensive ways to produce a variety of motion effects.

ImageModeler™

Instead of modeling complicated geometry, materials and lighting from scratch, ImageM odeler
allows computer graphics professionals to tap directly into the richness of the real world. The
software is the first high-end "Image-Based Modeler” to produce virtual 3D models from photo,
video and cinematic images. ImageModeler processes photo images and interprets them to define
a model’s geometry in 3D wire-mesh. The software then maps textures from the origina images
onto the wire-mesh. The resulting 3D model is accurate and highly realistic, and it can be
produced in less time and at much lower cost that conventional computer modeling techniques.

Stitcher™

Stitcher combines horizontally and vertically overlapping photos into stunning wide-angle, high-
resolution images in seconds. Panoramic images up to 360° X 360° can be exported to 2D
compositing software for creating high-definition, realistic matte paintings and to 3D software for
environment mapping. Of course, Stitcher panoramas can also be exported to ImageModeler for
generating 3D models. In addition, Stitcher allows filming in the panoramic image including
zoom, pan, tilt and roll camera motion. The resulting image sequences can be directly exported to
post-production software packages. Stitcher provides an alternative to on site shooting for
producing large background scenes, and it enables animators to work from high-resolution, very
wide-angle images. Stitcher is ideal software for reducing production costs.
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Introduction

Who should read this tutorial?

Thistutorial has been designed to allow any user of 3D animation software to quickly become familiar with

the 3D camera tracking process (also called match moving) using the REALVIZ’ MatchMover software.
Even if you are familiar with match moving, you should take the time to read this document to understand
how MatchMover software works.

What is contained in the tutorial?

Important:

Please note that you have an online version of the MatchMover Reference Guide. You can access
it under the Help menu within MatchMover. You may need to refer to the Guide during this
tutorial session.

This tutorial includes three sections. Each section is divided into successive steps. For each
intermediate step, a project file, or smply project, is supplied (.mmf file). By using these supplied
projects, you can move directly to the next step in the tutorial without executing all of the
MatchMover processes.

This version of MatchMover isa Full Use license. This license allows you full use of the features
of MatchMover AND you can export results for use in animation software without limit.

Tip:

The total size of the data in this tutorial is approximately 350 MB. It is not necessary to copy the
data to your local hard disk, you can run it directly from the CD-ROM. However, you can copy
the data to your local hard disk if you desire better performance.

To access the data associated with this document, browse the CD-ROM and gautoribédirectory.
The data for the first and second sections are itilitebdirectory.
The data for the third section is in tt#subdirectory.

Full Use Tutorial 3
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Goal of this Tutorial Session

The goal of thistutorial work session isto place a 3D computer-generated pencil container onto adesk. The
desk scene was previously filmed using a video camerain three different ways: shoulder held without and
with zoom and from a tripod with pan. These three image sequences are each used in this tutorial to track
camera movement.

Thefirst section, Orbital Camera Motion, is an image sequence created with simple orbital camera motion
without zoom. The camerafollows an arc of acircle around the scene. The section presents all the steps you
need to follow to be able to obtain the camera parameters.

The second section, Orbital Camera Motion with zoom, explains how to capture orbital camera motion with
zoom (the camera moves with various focal lengths).

The third section, Camera on a Tripod, explains how to capture camera motion with pan (the camera was on
atripod).

The second and third sections assume you understand the concepts explained in the first section.

Full Use Tutorial 4



Orbital Camera Motion
|

Orbital Camera Motion

The goal of thistutorial isto place a3D computer-generated pencil container onto adesk. The desk scene
(without the pencil container) was previously filmed with a shoulder-held PAL video camera without zoom.

To compute and check the 3D camera path, follow these five steps:

Track 2D pointsin the entire image sequence.

Define a 3D coordinate system relative to featuresin the 3D space.

Define geometric rel ationships between points in the 3D space.

Compute the 3D camera path and inspect numeric results for error.

Insert a 3D object and preview the scene along the computed 3D camera path.

grONE

When you are satisfied with your camera tracking results in MatchMover, the camera path and 3D points can

be exported directly to animation software including Maya™, 3D Studio Max®, LightWave 3D™ and
SOFTIMAGE 3D® formats. With the MatchMover camera data, you can create new animated image
sequences using the real live-action camera path. When these sequences are composited with the original
live-action footage, they will match perfectly. And, MatchMover’s computed 3D points can be used to
create accurate mattes for occlusions.

Getting started

1. Launch MatchMover.
The workspace appears in its default configuration.

2. SelectFile /7 New to create a new project.
MatchMover creates an empty project.

Full Use Tutorial 5
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Loading the image sequence

Select File /7 Load Sequence.

Browse the directories to open the Tutorial\t1 directory.

In the Files of type pull down menu, select the targaimage format (.TGA).

Select the file orbital 1.tga.

Enable the Set end check box and set the last frame to the number 100 to load only the first hundred
frames.

The image sequence was shot with a PAL video camera. Since video formats are interlaced, set the
I nterlace type to Even.

7. Click on the Open button to load the sequence.

agrLONE

IS

Open

Loak, i I £ Images:

= = &

g crbitall tga of abitall0d.tga ] orbitall 1.tga A arbital15.
A arbital 0.tga #f arbitall05tga & orbitall10tga 5 arbital 16,
af arbitall00tga & obital106.tga 8 arbitall11tga & orbitall17.
f arhitall0ttga & obitall07.tga 8 arbitall12tga & orbitall 18,
of arhitall02tga & orbitall08.tga 8 arbitall13tga &Y orbitall 19,
of arhitall03tga & obitall09tga 8 arbitall14tga 6 orbitall 2.
Jd | 3
File narne: Iu:url:-ital'l tga Open I
Filez af type: ITG.E'-. Files [*.tga) j Cancel |
¥ | Set end |1 ]

Interlace ype Mone Even & Odd I Detailz <<

MHb lmage: 100
width 720
Height A76

By default, MatchMover’s workspace is created with an image sequence viewer, calBdvilea. This
viewer allows you to navigate within the sequence by modifying the current time or by pan and zoom.

To learn more about all MatchMover views, refer to the MatchMover Reference Guide, chapter “Quick
Reference’l “Windows”.

Use the main toolbar to move in the seque A I 4 | 4 | 4 | "l M |

Or, while holding the Ctrl key, press the left arrow key to move to the previous frame. To move to the next,
first or last frame, press right arrow, home or end keys, respectively. You can use Ctrl + left mouse to
change the time by moving a virtual slider.

Full Use Tutorial 6
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Use the View menu to zoom and pan. Y ou can also use shortcut keys as follows:

to pan, use either Alt + left mouse button or the scroll bars;
to zoom out use the minus key (-);

to zoomin usethe pluskey (+);

to zoom in and out, use Alt + Ctrl + left mouse button.

See the MatchMover Reference Guide, chapter “Quick Referénhéeindows” [0 “Navigating within the
2D View Window.”

Tracking points in 2D

The pixel pattern in the area around the point you assign is used as a reference template. MatchMover looks
for a pixel pattern like the reference template in each successive frame. If the pixel area in the later frames is
a sufficiently close match to the reference template, points are tracked accurately. If the pixel area differs
significantly from the reference template, the point cannot be tracked well.

Important:

If you only track points that lie in the same plane, results may be poor. It is best to assign points
on at least two planes, for example some points on the desk and some on the face of the PC
monitor. ldeally, the points you assign will be spaced over the entire volume of the 3D scene.

The points you assign should be points that are easy to distinguish visually. Remember, MatchMover is
looking for a very similar pixel area in each successive frame, i.e. pixel areas that can be accurately
recognized in each frame. For example, a wall outlet shows a distinctive small, dark pixel pattern that is
easy to track because of its high contrast and small size. The points you assign should represent physical
points in the scene (e.g. dots, corners of objects or intersections of two bold lines).

Before running the tracking process, study the sequence and select the points you want to track.

You should not use:

- points not on actual 3D objects like the meeting points of the edges of a foreground and a
background object where the two objects overlap visually but do not actually touch.

- points that can not be accurately localized in the image, e.g. pointsin large, uniform pixel areas
or points located along linear edges like the middle of a long line or the middle of a long edge of
an object. For example, a point designated in the middle of a long dark edge cannot be easily
recognized from a similar one closer to the end of the same dark edge.

Full Use Tutorial 7
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Tracking a point

In the 2D View,
1. Setthecurrent timeto the first frame (Ctrl+Home).
2. Click on the right mouse button to open a pop-up menu and select NewTrack. The cursor changes from

0
%to =l|=.

3. Click on acorner of the book that lies on the desk and drag the cursor into position.

4. Runthetracker forward (F3). The Tracking Monitor window pops up, displaying the evolution of the
tracked pattern through the sequence. If the tracking is successful, the pattern should look stable.

5. You can change the “label” of this point by pressingAher Enter keys to open the point’s property
box. You may want to label each of your points the same way they are labeled in this tutorial.

Properties H |
| !

Label IDesk 05 Uszed For 30 Tracking W

# I'I h3.2h Feconstructed in 30 W

v [272.25 Color B

Tip:

Right click in the 2D View to open the pop-up menu and select the Lock On Track mode to keep
the selected point track in the center of the view.

Full Use Tutorial 8
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Checking the result

In the Track View, acolored lineis displayed above the tracked point. If thelineisgreen, thetrackingis
good quality. Yellow and red mean fair and poor quality tracks, respectively.

MatchMover allows you to improve on the track by changing the point you assigned to an intermediate key
and moving it. MatchMover can also track forward or backward. This processis called bi-directional

tracking.

1. Intheright pane of the Track View, double click on the point at the time corresponding to the potential
problem.

2. If the point has drifted, go to the end of the image sequence and use 2D Tracking /7 Set Key to change
the point to an intermediate key. Y ou can then manually reposition the assigned point so that it matches
as accurately as possible to the same point you first assigned.

3. Run bi-directional tracking (F4) to track the point again.

= 543 Point Tracks =] [0 [10 [E] [30 [0 |50 ] [F0 [0 B0

| Lok Desk O ———— + —
Ay Desk 02

Ak Desk 03

Ak Desk 04

Ay Desk 08

Ak Sereen 01
Ay Sereen02

i gk Sereen
A walor o

L0 IR 13 g |

Tip:

When tracking a point that drifts, you should set as many intermediate keys as needed because
they improve the accuracy of tracking, You should also set a key at both the first frame and the
last frame. Setting these keys and running the bi-directional tracker corrects drift in the point
track and improve the overall track quality.

4. Repesat the assign/track process until you have tracked at least 8 points that cover the entire scene. Or,
you can continue the tutorial now by using the file orbital.rz2 that contains all the point tracks used in
this tutorial.
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Importing the 2D points from the first section

Select File 7 Import to open the import dialog box.

Select the REALVIZ ASCII Point Tracks (.rz2) format.

Browse the directories and select the file Tutorial/ /t1/orbital .rz2.
Click on Open.

PR

Thefile stepl.mmf contains the project at the end of the point tracking steps.

The picture below shows the nine points that have been tracked in the orbital.rz2 file:

Full Use Tutorial 10
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Creating a coordinate system

There are several advantages in defining a system of coordinates in a specific way.

First, the way you define coordinate can make things easier and more intuitive in the next stages. For
example, when you insert virtual objectsin the scene, they are usually placed on aflat surface like the desk.
In this case, it is very convenient to have two coordinate axes, say X and Z, set in the plane of the desk.

Second, awisely chosen coordinate system allows you to very easily impose geometric constraints on
certain points. These constraints define obvious alignments in the scene that are easy to see. An example of
such a constraint might be, "the screen corners are at the same height above the desk, so they should have the
same Y coordinate”. These constraints help improve the accuracy of tracking and they result in a higher
quality composition when 3D objects are mixed with live-action footage.

In this example, you are going to create a coordinate system defining the plane X-Z plane on the desk. The
Y-axisisthe vertical axis normal to the desk.

Tip:

Depending upon the 3D-animation package you use, define the axisto either have Y up or Z up.
The coordinate axis you define in MatchMover should be the same as the axis in your animation
software.

Full Use Tutorial 11
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Setting the origin and the scaling

1. IntheProject View, right click on the Coordinate System folder to open the pop up menu. Select
the New Coordinate System item.

2. Double click on the Coords 01 item to open its property box.

3. Settheorigin of your coordinate system on the Desk 03 point.

4. Define the distance between two points, Desk 04 and Desk 05, to be 10.0 units.
(The distance between two chosen points defines the coordinate system scaling.)

Propetties @
Generdl | Auis | -
Label ID:u:uru:Is m Distance |1EI.EIEIEI
Oigin [Desk03 =] |Desk0os | |Desk0s x|

Tip:

If you set the distance between the points Desk 01 and Desk 02 to 22 units, which is the actual
width in centimeters of the brochure that is on the desktop, the 3D units will all bein centimeters.

Full Use Tutorial 12
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Defining the axis

1. Open the Axis page on the Properties dialogue box .

2. Axisl defines a coordinate axis, X in this example. The axisis defined as a line passing through two
points. Usually the origin is chosen along with one other assigned point (Desk 01). But, you could
choose any two points.

3. YoucandefineY or Z asthe second axis. In this example, we have chosen to define the Z axisfrom
origin to point Desk 02.

Properties [
General Az | a2
Axis] | from origin to =] Axis2 | from origin to =]
[ =] |Desk ol |z =l |Desknz

[ [
| Jid | =
| 2 | 2

Tip:

The second axis does not need to be orthogonal to the first axis. You may create either
orthogonal or non-orthogonal axis for convenience.

4. Todefinethe vertical axis accurately relative to the desk, we can set the axis normal to the plane
passing through three points on the desk. For Axis2, Y, select theitem normal to three points and
choose the points Desk 01, Desk 02 and Desk 03. All of these pointslie in the plane of the desk
defined by the axis X and Z.

Note:

The third axis is automatically defined to be orthogonal to the first two axes.

e > ||
General Awis | ot
dxis]  |fomoriginte 7] xis2  |nomalto 3 points 7
[x =] |Deskot = [v =] |Desk o2 =
| =l |Desk m =l

| o
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Defining relations between points

MatchMover reconstructs the live-action footage into accurate 3D space. To increase the precision of the
reconstruction, you can indicate the position of certain points or the shared constraints of certain points.

In this example, it is obvious that the points Desk 01, Desk 02, Desk 03, Desk 04 and Desk 05 are all at the
same height since they are al in the plane of the desk. To set this constraint, do the following:

1

2.
3.
4

In the Project View, right click on the Point Relations folder and create a new relation.

Or, Double click on the Point Relations to open its property dialogue.

Set the type of the relation to Share Y.

Select the points Desk 01, Desk 02, Desk 03, Desk 04 and Desk 05 in the rightmost list box.

Click on the left arrow button to add the selected points to the list of points sharing the relation. Be
sure the Enable box is checked.

Properties E |
— - a]
i General §

Label IHEIatinn 01 Desk 0
Desk 02

Tupe Chare ' | |Desk 03
#F [Share =] Desk 04
Status ILInkn-:uwn vI Desk. 05
Walue I Enable v

Dzl 0
Desk 02
Desk 03
Desk 04
Deszk 05
Screen 11 ;I

|

This point relation forces MatchMover to compute these 3D points so that they lie exactly on the same plane,
the desk in this example. Without these constraints, MatchMover cannot know these points are in the same

plane.
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Computing the 3D camera path

Before running the camera tracker you need to define the characteristics of your camera. In this tutorial, you
only know that the sequence was shot from a PAL camera without any zoom.

1. IntheProject View, open the Camerasfolder. Right click onthe Camera 01 item and open the
Property dialogue.
2. Onthe General page, select a cameraof type PAL.

Properties ________________________________H
==

General I Focal Lengthl Advanced I Caonstrainks I Parameters I

Label IEamera 1 Type ({SF1H -
Filmn B ack Width IEI.?EIE Height IEI.EEM inch =
Image Resolution Width IF"EEI Height IEFE Ratio |'|.25EI

Pixel Azpect Ratio |1 OBET I Fixed j

3. Openthe Focal Length page.

4. Set the focal length to Constant initialized because you know that there is no zoom. Leave the
starting value to the defaullt.

Properties ________________________________H
: i

FocalLength |Canstart intislized x| [50.0000  fmm =]

5. Tobeableto easily composite the scene in any 3D package, leave the advanced parameters to their
default values (principal point and distortion).

6. Runthe cameratracking by either selecting 3D Tracking /7 Track Camera, by pressing the F9 key
or by clicking on the & i con.

The step2.mmif file contains the project after the camera tracking process. Y ou can open it in the next
section to continue with the tutorial.
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Previewing the results

There are two ways to check the quality of the cameratracking results. The first way isto ensure that the
reconstructed points are numerically correct. The second way isto inspect the camera path visually.

Numeric check

The numeric check is done by comparing the position of the 2D tracked point to the projected position of the
computed 3D point. In the Track View, the uppermost colored line indicates the quality of the point tracking.
Green is good, yellow isfair and red is poor.

| ER=1 [ — e

‘a Sequence 01 e —
ED Pairt Tracks
[ Cameras P = < o O - P 1

The Survey Views contain more information about the precision of the calculated data.
Select Window £/ Survey View to display an existing Survey View or Window 7 New View [J Survey to
Cregte a new one.

The Survey Views allow you to check the resultsin three ways:
1. For each point, the average deviation of the 2D point position to the 3D computed point position is

shown in pixels. If any point has an error clearly greater than the errors of most other points, check
the 2D tracking path of thispoint. If necessary, you can assign new Intermediate Keys and track the

point again.
Fuirt | 30 Pesidual |
Desk 01 0.2359
Desk 02 0.4309
Desk 03 03333
Desk 04 02385
Deszk 05 0.4352
Screen 01 01738
Screen 02 0.2070
Screen 03 0.3553
whall 01 01706

2. Todisplay the frame deviation, Display £/ Survey Mode /7 Frames. For each frame, the average of
the deviation error for all pointsin the frame is displayed. If aframe has an error clearly greater than
those of the other frames, check the position of the 2D pointsin this frame.

Frame I 30 Rezidual | -
07206 -
06305
[0.6352
0.6209
[0.54EE
[0.E039
0.5150
[0.4864
04916

0.4299 -|
I >

3. Todisplay the deviation of each point in each frame, Display /7 Survey Mode 7 Points and
Frames. For each frame the deviation error for each point is shown. It is useful to sort this window

000 ] T e DO — T
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by descending 3D Residual in order to find the points and the images that have been poorly

calculated. Click on the header of the 3D Residual column to sort the residuals.

Frame |  Point | 2D Qudity | 30 Fesidual |

0 Diesk 01 0.8000 0E778 —
1 Diesk 01 0.9515 0.7458

2 Diesk 01 0.9104 0.9188

3 Diesk 01 0.8979 0.7130

4 Diesk 01 0.8914 06106

5 Diesk 01 0.9706 05502

E Diesk 01 0.8042 07324

7 Diesk 01 0.8665 07261

8 Diesk 01 0.8687 01736

g Diesk 01 0.59442 0.4270

10 Diesk 01 0.9506 02424

11 Diesk 01 0.9275 05279

12 Diesk 01 0.58765 01764 <
12 Mesle 0 n a0 n ANCE

Before exporting the data to the 3D animation package, the final check isvisual. You caninsert a 3D object
into the scene and visually check that it is stable when you run the image sequence. In this example, itis
convenient to place an object on the desk by aligning the object on the X-Z plane at Y=0.

Full Use Tutorial
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Visual check

Select Window /7 3D View to open an existing 3D View, or if none exists, select Window /7 New View /7
3D to create a new one.

By default, the 3D view opensin Free Cameramode. The viewpoint can be changed to view the 3D scene
from any position by panning, rotating, zooming, etc. To review the 3D viewing shortcuts, check the online
Reference Guide, chapter “Quick Referenide"Windows” O “Navigating within the 3D View window:
Free Camera Mode”.

To check the match between the real camera and the reconstructed one, insert a 3D object into the scene.
1. Right click in the 3D View to open the pop-up menu.
2. SelectNew Primitive/7 Cylinder.

A cylinder is created, centered on the origin of the current coordinate system and surrounded by a
manipulator. This manipulator allows you to freely translate, rotate or scale the selected object by clicking

on the arrows, the circles or the cylinders, respectively, and dragging the mouse while pressing the mouse
button.

In order to precisely position the object on the desk use the alignment feature described on the next page.
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Aligning the object on the desk

1. Click onthe object to select it.

2. Click the right mouse button to open the pop-up menu and select the Select Manipulator 7
Alignment item.

3. A menu appears on the right of the 3D View.

4. Select the small button in the center of the cylinder’s base.

5. Click onthe Grip item in the menu to accept the selection.
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6. Select 3 pointsthat lie on the desk to define the plane of the desk.

7. Click on the Align item in the menu to align the cylinder on the desk. This operation brings the
selected face of the cylinder onto the plane of the desk.

8. Depending on the way in which you clicked the 3 paints, the cylinder appears correctly or reversed.
If it isreversed, click on the Flip item in the menu to position it correctly on the desk.

9. A new manipulator appears that allows you to move the object in the plane of the desk. Use the
circleto turn the object. Use the triangle to move the object while keeping it correctly aligned on the
desk. Usetheline to move the object vertically.

10. When the object is correctly placed in the scene, click on the Done item in the menu.

If you wish to preview the results with more complex objects you can use the File /7 mport menu to import
3D objects of the Wavefront .OBJ format.

Note:

There are no .obj filesincluded in the tutorial data set.

To ensure that the 3D objects remain perfectly fixed in position, it is necessary to view the composited
images at video rate. This can be achieved by generating a preview sequence in AV1 format and replaying it
at normal speed.
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Generating an AVI sequence

1. Select 3DScene /7 Render Setup to open the Render Setup dialog box.
2. Enter the path and the name of the file to generate.
3. Usethe Setup...button to choose a compressor (the default compressor is Microsoft Video 1).
4. Select the output file resolution and the range of framesto render.
5. Enable the Antialiasing check box to smooth the rendering of the scene.
6. Click on Render
Render Setup |
File: M ame IF'Z"-.EEdE[DI‘I‘IS"-.TutDriElr‘-.H preview . Browse. .. | Setup... |
Si Fulll = e :
= IFulinage =] ¥ antialiasing
Resolution  [100% x| 720 Y [576 I Distotion
Length |Full File o 100

Cancel | Cloze | Bender I

The samplefiles previewl.avi and preview2.avi contain results that you can compare to your own.

The file step3.mmifcontains the final results of the project for this section of the tutorial.
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Exporting the camera path

1. Sedlect File [7 Export to open the Export dialogue box.

2. Set thetype of thefile for the desired format (ASCII, 3D Studio Max, SOFTIMAGE 3D, Maya or
LightWave 3D).

3. Enter the path and the name of thefile.

Refer to the chapter “Exporting” in the MatchMover Reference Guide to understand how to use this
exported file in your 3D animation software.

The filesorbital 1.rz3, orbital1.ms, orbital1.xsi, orbital1.ma andorbital 1.lws contain the exported data in
ASCII, 3D Studio Max, SOFTIMAGE 3D, Maya or LightWave 3D formats, respectively. You can load
these files into your animation software to see how this tutorial project will appear after rendering the 3D
objects.

Result after rendering in 3D Studio Max.
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Orbital Camera Motion with Zoom

The aim of thistutorial isto place a computer generated pencil container on a desk filmed with a moving
camerathat has a varying zoom during the sequence.
Y ou use the same sequence as the previous section, but you load more frames.

Getting started

1. Launch MatchMover.
The workspace appears in its default configuration.

2. Select File [7 New to create a new project.
MatchMover creates an empty project.

Loading the image sequence

In the File menu,

Select the Load Sequence item.

Browse the directories to open the Tutorial\t1\l mages directory.

In the Files of type pull down menu, select the targaimage format (.TGA).

Select the file orbital 1.tga, which is the same sequence as used previously.

Select the Even Interlace type.

Click on the Open button to open all the frames (181). The sequence used hereislonger than in the
previous exercise. Zoomis present in the later frames.

If you don'’t see the image sequence, make sure you are in 2D View.

o,k wNE

~
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Open

Laak. jr: I'a Images j | Eﬁl

e of abitall0d.tga ] orbitall 1.tga A arbital15.
A arbital 0.tga #f arbitall05tga & orbitall10tga 5 arbital 16,
af arbitall00tga & obital106.tga 8 arbitall11tga & orbitall17.
f arhitall0ttga & obitall07.tga 8 arbitall12tga & orbitall 18,
of arhitall02tga & orbitall08.tga 8 arbitall13tga &Y orbitall 19,
of arhitall03tga & obitall09tga 8 arbitall14tga 6 orbitall 2.
KN

File narne: Iu:url:-ital'l tga Open

Filez af type: ITG.E'-. Files [*.tga)

[ Setend |1E1

Mone

Interlace type

Even

[

Odd

MHblmage: 181
width 720
Height A76

Cancel

i I,
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Tracking points in 2D

In the previous section we already tracked 8 points for the 100 first frames. Y ou can either import the file

you have previously saved or use the orbital.rz2 that we have provided (this file contains the points tracked
inal the frames). You can also track new points.

Importing 2D points
1. Sedlect File 7 Import to open the Import dialog box.

2. Selectthe REALVIZ ASCII Point Tracks (.rz2) format in the t1 directory.
3. Select the <project_name>.rz2 file and open it.

Import
Laak jn: Iat'l j il nins {55

Images

File name: Il:url:uital.r22 Open I
Files of type: IFEE.-’-‘-.LVZ Aol Point Tracks [7rz2] j Cancel |
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Computing the 3D camera path

Before running the camera tracker you need to define a coordinate system, the point relations and the
characteristics of your camera. In thistutorial, you know that the sequence has been shot from a PAL video
without any zoom for at least the first 100 frames, and with zoom to the end of the shot.

In the Project View,

1

2
3.
4,
5

Create a coordinate system.

Create apoint relation for the points that lie on the desk.

Right click on the Camera 01 item and open its property panel.

Open the Focal Length page.

Set the focal length to Variable I nitialized because you know that there is some zoom variation.
Leave the starting value to its default value (50mm).

Properties ______________________________H
_W

FocalLength  [ariable initislized =] [50.0000  [mm =]

Since we know thereis no zoom in the 100 first frames, we now create a camera constraint to provide this
information to the camera tracker.
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Defining a camera constraint

1. IntheProject View, right click on the Camera 01 item and select the New Constraint item.
2. Open the constraint Focal Length 01 property panel.
3. Set thetype of the constraint to I nitialized.

Pioperties _____________H|
. P -W
Label IFn:n::aI Lerigth 01 Type I Initialized j
Fararneter I Focal lergth j Walue IEEI.EIEII:IEI

Enahble v

4. Inthe Track View, press the Shift key and click and drag the left mouse to select the 100 first frames
of the sequence.

| [ Image Sequences . ] ] T

LN IL AL

7l Screen 02 - E fO,. . . k0. ., o0, . oy, i, i
»

=" |~ e |

5. Check that the constraint Focal Length 01 is selected (in the Track View).

6. Intheright pane of the Track view, right click to open the pop-up menu and select the Add Frames
item to add the selected frames to the current constraint.

7. Pressthe Shift key and right click in the Track view to reset the time range.

Y ou can now run the cameratracker and check the results.

The file step4.mmf contains the final results of the project for this section of the tutorial.
The file preview3.avi contains results that you can compare to your own.

Thefiles orbital2.rz3, orbital2.ms, orbital2.xsi, orbital2.ma and orbital 2.lws contain, respectively, the
exported datain ASCII, 3D Studio Max, SOFTIMAGE 3D, Mayaand LightWave 3D formats.
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Cameraon atripod

The goal of thistutorial isto place acomputer generated pencil container on adesk filmed with a cameraon
atripod. Thereispan movement in the image sequence.

Camera movement on atripod or within a travelling motion often creates image sequences with little or no
parallax information. By parallax we mean the apparent relative motion between objects in the foreground
and objects in the background.

Some footage may not have sufficient parallax for MatchMover to track points accurately. When the
footage does not have sufficient parallax, you can introduce parallax information to the project by importing
additional still images shot from different positions on the set. These additional frames are called helper

frames.
/’”‘“\V
Helper 1 Helper 2
Tripodd
Tip:

If you are going to track image sequences with no or little parallax, the best way iswith Hel per
frames. Helper frames are shot in the production stage (like Helper 1 and Helper 2 in the above
figure) using a still camera. The Helper frames provide the information required to capture the
camera track in the post-production stage when thereis little parallax in the live-action footage.

If you do not have helper frames, you can use point relations to input 3D measurements of known
pointsin order to provide 3D information to MatchMover. This additional data will enable
MatchMover to track points accurately.

If you have old footage with little or no parallax and no helper frames, you can still capture
camera motion by creating 3D points using point relations. Usually, the location of some points
can be discerned by observation. Place these points and track them. Use the editing tools to
improve tracking. Check the results by inserting a 3D object and generating an AVI. You may
not get perfect results every time, but these camera tracks may still save you time!

Important:

If you use point relations to input 3D measurements you must input at least four pointsthat are
not coplanar.
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Getting started
1. Launch MatchMover.

The workspace appears in its default configuration.

2. Select File [7 New to create a new project.
MatchMover creates an empty project.

Loading the image sequence

In the File menu,

1. Select the Load Sequence item.
Browse the directories to open the Tutorial\t2 directory.
In the Files of type pull down menu, select the targaimage format (.TGA).

2
3.
4. Select thefiletripodl.tga and Even Interlace type.
5

Click on the Open button to open all the frames (100).
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Files of tupe: ITGI-'-. Files [ tga)

[T Set end I'IEIEI

Maone ©

Interlace type

[

Odd

Mb Image: 100
"Width 720
Height B7E

Open
Laak. in: Ia images

?rru:uu:ﬂrga ﬁ tripod14.tga ﬁ tripod?2.tga ﬁ tipod25.tg
ﬁ tripod10.tga ﬁ tripod15.tga ﬁ tripod20.tga ﬁ tripod26.tg
ﬁ tripod100.tga ﬁ tripod16.tga ﬁ tripod21.tga ﬁ tripodZ7 .t
ff tripod11.tga ff tripod17.tga ﬁ tipodZ22. tga ﬁ tripnd2a.tg
ﬁ tipod] 2. tga ﬁ tipod18.tga ﬁ tipod23.tga ﬁ tipod29.tg
ﬁ tipod] 3.tga ﬁ tipod19.tga ﬁ tnpod24.tga ﬁ tipod3.tga
KN
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Cancel
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Computing the 3D camera path

Y ou can either import the tripod.rz2 file we provide or track your own 2D points.
Create a coordinate system.

Set the parameters of the camera.

Run the camera tracker.

Open the survey window and check the results, they are probably poor.

agrwNE

Tip:

Remember that a good result means that the distance between the 2D points and the reconstructed
3D points (the 3D residual) is less than one pixel.

Because there is not enough parallax in the image sequence, the cameratracker cannot compute the camera
parameters. Y ou need to provide more 3D information to the tracker. Y ou can either measure 3D pointsin
the scene and create point relations with fixed point values, or you can add still pictures of the same scene
shot from different view points.

In this tutorial session, you are going to import two additional frames shot from different position to
introduce parallax information to the project. On areal project, this will be the least expensive option for
capturing the information MatchMover needs to track camera motion.

Thefile stepl.mmf contains the project for the next steps.
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Loading the helper frames

The two helper frames used in this tutorial have been shot with the same camera and with the same focal
length. When loaded together, the two images share the same camera.

In the File menu,

Select Load Images.

Browse the directories to open the Tutorial\t2 directory.

In the Files of type pull down menu, select the jpeg image format (.JPG).
Select the files helperl.jpg and helper2.jpg.

Leave the I nterlace type to None.

Click on the Open button to open the two helper frames.

oA~ LNE

Open
Look jr: I e

File name: I"HelperDE.ipg" "Helper .jpg" Open I
Files of type:  [JPEG Fies [~jpg; *iped) [ Cancel |
Interlace type Mone & Even Odd ﬂl

Assigning 2D points

For each point track, assign the 2D point in the helper images.

Select a point track.

Set the current time in order to display the first helper frame.

Click in the helper frame at the corresponding position of this point.
Set the current time in order to display the second helper frame.
Click in the helper frame at the corresponding position of this point.

ISAE S

Repeat this process for all the point tracks.
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Re-computing the 3D camera path

The digital camera that we used to shoot the two helpers images has generated some non-linear distortion.
Y ou can see that straight lines appear slightly curved, especially close to the edges of the image.

Before tracking the camera, modify the settings of the camerato allow the camera tracker to calculate this
distortion.

Select the camera that has been automatically associated to the helper frames (Camera 02).
Open its property box (Alt + Enter).

Open the Advanced page.

Set the Distortion parameter to Constant initialized.

PR

Properties ______________________________H
_W

Generall Focal Length  Advanced | Eunstraintsl F'arametersl

Principal Paint | Fised x| % [osoo0 v [osooo
[0.0000

Digtartion Conztant intiahzed Y

5. Repeat the same operation for the camera associated with the image sequence.
6. Runthe cameratracker (F9).

Tip:

If your 3D-animation package does not allow you to input the distortion value in the render tool,
you have to set the distortion type to Fixed and its value to O before running the camera tracker.
MatchMover will then find the most satisfactory distortion-free solution to the problem.

Full Use Tutorial 31



Camera on atripod

Previewing the results

1. Inthe Survey View, check the values of the residuals.
2. Openanexisting 3D View or create anew one.
3. Createanew 3D primitive.
4, Alignit onthe desk and check that it staysin position.
5. Generate an AVI sequence to play the composited sequence in real-time.
Generating an AVI sequence with distortion
1. Select 3DScene /7 Render Setup to open the Render Setup dialog box.
2. Enter the path and the name of the file to generate.
3. Usethe Setup...button to choose a compressor (the default compressor is Microsoft Video 1).
4. Select the output file resolution and the range of frames to render.
5. Enable the Antialiasing check box to smooth the rendering of the scene.
6. Enablethe Distortion check box to render the 3D scene with the computed distortion of the camera.
7. Click on Render
Render Setup |
File Mame IP‘:'xl:ederDms"uT utonial't2hpresdew. a Browse... | Setup... |
Si Fulll -
= I W mage J V¥ Antialiasing
Resolution [50% | [360 Y |288
Length  [User = o {100
Cancel | Cloze | Bender I

Note:

edges of the image).

normal.

In the 3D View, the background image is sightly deformed to compensate for distortion (see the

In the AVI sequence, 3D objects are deformed dightly while the image background remains

The file step2.mmifcontains the final results of the project for this section of the tutorial.

Thefile preview.avi contains results that you can compare to your own.

Thefilestripod.rz3 tripod.ms tripod.xsi, tripod.maand tripod.lwscontain, respectively, the exported data

in ASCII, 3D Studio Max, SOFTIMAGE 3D, Maya and LightWave 3D formats.
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